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About this manual
1  About this  manual

The Busy Lamp Field program BLF-Win displays the ringing states of the configured 
subscribers and subscriber groups. 
BLF-Win works in conjunction with AC-Win IP V2, AC-Win SL and DS-Win V4.

.
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Features and overview of BLF-Win
1.1  Features and overview of BLF-Win

• User interface

– Color-coded status display

– Phone States: Idle, Ringing, Busy, Out of service, Does not exist

– Option of displaying station numbers or names

– Display of different index cards 
(for example, for a number of departments)

– Customized configuration and design of the program window.

• Display of up to 1000 subscribers permitted

– Individual telephones (for example, executive telephones), subscriber ranges (for 
example, agents)

– Note function provided when subscribers and subscriber ranges are created. The 
note appears in the fast tip.

• Integrated workflow with other applications

– Interfaces to AC-Win (attendant console) and DS-Win (address database)

– Interface to Outlook Exchange

– Switching function available by clicking the station number field

– Call forwarding feature can be enabled

– Status displays provided when the search function is selected in the DS-Win task 
bar. 

NOTE:  Hunt groups are not supported in the versions 1.0, 2.0 and 3.0 of BLF-Win.
 A31003-H3200-B555-6-7619, 01/2020
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About this manual
1.2  Benefits of this program to the customer

• Extensive information about switching using subscriber states and the consequent 
avoidance of unsuccessful switching operations

• Reliable information display during incoming calls regarding the connection request

• Shorter switching times and a consequent increase in productivity

• Secure place in future markets through the use of a standard platform and integration 
in Unify applications

• Flexibility provided by the LAN design

• Integrated in the Unify service infrastructure
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Starting the program
1.3  Starting the program

BLF-Win Client is designed for continuous operation and is usually started by the system 
administrator. 

You can start the program in one of two ways if you have to call the program yourself for 
operational or maintenance reasons:

Double-click the BLF-Win icon or

Click: Start / Programs / BLF-Win 3.0 Client / BLF-WinClient. 

The main window appears after you have started BLF-Win Client. 
 A31003-H3200-B555-6-7619, 01/2020
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The main window
2  The main window

This chapter describes the structure of the BLF-Win program.

The main window contains the following components:

• the title bar 

• the menu bar 

• the index cards

• the display panel with:

– the subscribers

– the subscriber ranges

• the legend
A31003-H3200-B555-6-7619, 01/2020
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Title bar
2.1  Title bar

The title bar is located at the top of the main window. It contains:

• the program names

• the status of the connection with the OpenScape 4000

• the name of the currently open file

2.1.1  Connection status

Not connected status

The figure below illustrates BLF-Win-Client in "disconnected" status. All extensions are 
displayed in gray, which means that they are out of service (Chapter 2.3.3, “Subscriber”).
 A31003-H3200-B555-6-7619, 01/2020
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The main window
Connected status

The subscribers are displayed using the various color-coded status options in the 
connected status (Chapter 2.3.3, “Subscriber”).

2.2  Menu bar

The menu bar is located underneath the title bar in the main window and displays the 
following drop-down menus.

The functions of the drop-down menus are described in the section entitled "Using 
BLF-Win".
A31003-H3200-B555-6-7619, 01/2020
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Display panel
2.3  Display panel

The telephone calls conducted by the subscribers and subscriber ranges are displayed in 
the display panel using different colors. The color used depends on the current status of the 
call. 

You can customize the display panel by right-clicking in the relevant fields.

2.3.1  Index cards

The index cards are located underneath the menu bar in the main window.

You can find out how to create new index cards or edit existing ones in Chapter 3.3, “Editing 
index cards”.

2.3.2  Subscriber range

Subscribers from the same department can be grouped into subscriber ranges. The 
subscriber range or ranges configured are displayed in the display panel. A subscriber 
range can contain up to 10 subscribers.

You can find out to how to create a new subscriber range or edit an existing one in Chapter 
4.3.1, “Creating a new subscriber range”.
 A31003-H3200-B555-6-7619, 01/2020
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The main window
2.3.3  Subscriber

The station numbers/names are displayed in table form in the display panel.

NOTE:  A fast tip indicating the name of the subscriber, The subscriber’s status (phone) 
and a short note appears if you position the pointer over a subscriber.

You can also configure the display panel to display the names of the subscribers. (Chapter 
3.5.5, “Displaying names”).

The connection states of the subscribers are displayed in different colors.

You can change the color settings as required (Chapter 3.5.13, “Defining colors”).

You can use a drag-and-drop operation to arrange the subscribers and the subscriber 
ranges in the display panel to suit your requirements.

The subscriber is idle. The subscriber can 
receive a call or initiate a call at any time.

The subscriber is receiving a call or is 
making a call (ringing state). The 
subscriber's telephone or the call party's 
telephone rings but a connection is not 
set up yet. 

The subscriber is configured in 
OpenScape 4000 but is not connected to 
the OpenScape 4000.
The subscriber cannot make a call or 
receive a call. 

The subscriber is dialing a calling number 
(dialing state) or currently conducting a 
call (talking state). 

The subscriber is not configured in the 
OpenScape 4000. 
A31003-H3200-B555-6-7619, 01/2020
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Display panel
NOTE:

While in busy state, you can see if the call is either external or internal. In case of an external 
call, either incoming or outgoing, an additional sign, i.e. arrow pointed down, will be shown 
near the subscriber’s number/name. 

This symbol is only displayed while a subscriber is in busy state.

For internal calls, the default busy status will be displayed, i.e. no additional sign/hint.

The fast tip is also updated with a hint that the call is external. 
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Using BLF-Win
3  Using BLF-Win

This chapter describes the different functions and commands of BLF-Win.

The menu bar is located under the title bar in the main window. 

The figure below displays all menu options contained in the drop-down menus in the menu 
bar: 

A dialog box usually opens when you click a menu option. The dialog box entries have the 
following meaning:

The entries should take effect.

The entries should take effect.

The entries should not take effect.

The settings in the *.ini configuration file will be 
loaded and will take effect. 

The process is canceled. The settings will be reset to 
their former state.
A31003-H3200-B555-6-7619, 01/2020
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Configuring BLF-Win
3.1  Configuring BLF-Win

The File drop-down menu contains functions that allow the user to configure the display 
panel. 

The following functions can be executed:

NOTE:  The Save and Save as... menu options can only be selected if you have entered 
the correct password under Tools/User / Administrator mode in the menu bar ().

Create a new configuration

Open a saved configuration

Save a configuration

Save a configuration under a different name 

Exit BLF-Win Client
 A31003-H3200-B555-6-7619, 01/2020
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Using BLF-Win
3.1.1  Creating a new configuration

You can use this menu option to create new configuration files.

All index cards, subscribers and subscriber ranges are deleted from the user interface when 
you create a new configuration.

1. Click File in the menu bar.

2. Now click New (the instructions contained in step 1. and 2. are combined in the 
subsequent description as follows: File / New.

A new, blank display panel opens.
A31003-H3200-B555-6-7619, 01/2020
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Configuring BLF-Win
3.1.2  Opening a saved configuration

This menu option opens an existing configuration.

1. Click File / Open in the menu bar.

The program prompts you to confirm whether you want to save the changes if a 
configuration is already open.

2. Enter the name and directory of the configuration file or select a name from the list. 

The selected configuration file opens.

3.1.3  Saving a configuration 

The Save menu option is used if you want to save the current configuration. 

NOTE:  The Save and Save as... menu options can only be selected if you have entered 
the correct password under Tools/User / Administrator mode. 

1. Click File / Save in the menu bar.

The file is saved. 

3.1.4  Saving a configuration under a different name

The Save as... menu option is used if you want to save the file under a different path or a 
different name. 

NOTE:  The Save and Save as... menu options can only be selected if you have entered 
the correct password under Tools / User / Administrator mode.

1. Click File / Save as... in the menu bar.

2. Enter the name and directory of the configuration file or select a name from the list. 

The file is saved. 
 A31003-H3200-B555-6-7619, 01/2020
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Using BLF-Win
3.2  Exiting BLF-Win 

This menu option is used to exit BLF-Win.

1. Click File / Exit in the menu bar. 

The applications are closed and BLF-Win is terminated. 

A dialog box prompting you to confirm whether you want to save any unsaved files appears.

3.3  Editing index cards 

You can create new index cards and you can open, delete or rename existing ones. 

3.3.1  Creating a new index card

1. Click Edit / New index card... in the menu bar.

2. Enter a name for the new index card, for example, customer service.

3. Confirm your entry by clicking OK.

The new index card appears in the subscriber range to the right of the existing index 
cards. 
A31003-H3200-B555-6-7619, 01/2020
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Editing index cards
3.3.2  Deleting a specific index card 

1. Click the index card to be deleted. 

2. Click Edit / Delete actual index card... in the menu bar. 

3. Click Yes. 

The selected index card is deleted.

3.3.3  Renaming a specific index card...

1. Click the index card that you want to rename. 

2. Click Edit / Rename actual index card... in the menu bar. 

3. Enter a new name for the index card. 

4. Confirm your entry by clicking OK.

The index card is renamed.
 A31003-H3200-B555-6-7619, 01/2020
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Using BLF-Win
3.4  Activating call forwarding

You can use this menu option to activate the call forwarding feature for a selected 
subscriber. 

1. Click Edit / Call forwarding....

The user can select the name of the subscriber whose calls are to be forwarded from a 
list of all available subscribers. 

2. Go to the Forwardable subscribers box and select the station number of the subscriber 
whose calls are to be forwarded. 

3. Select the ImmediateOn option in the Forward type combo box.

4. Enter the call forwarding destination.
– Enter the number in the VoiceMail box if you want to allow callers to leave you a message. 
– Use the Destination box to enter the number of the subscriber to which the incoming calls should be 

forwarded. 

5. Confirm your entry by clicking OK.

All subsequent calls are automatically forwarded to the specified destination. 

An arrow appears in the display panel field of the subscriber whose calls are to be 
forwarded. 
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3.5  Changing the view in BLF-Win

You can use this drop-down menu to select different views.

The check mark indicates that the function is activated. 
The function is deactivated if no check mark is displayed.

3.5.1  Deactivating the menu bar

You can show or hide the menu bar using the View/Menu options. 

1. Click View/Menu in the menu bar.

The display of the menu bar in the main window is deactivated. 

3.5.2  Reactivating the menu bar

1. Position the mouse pointer in the title bar.

2. Click once with the right mouse button.

3. Select the Show menu option.

The menu bar reappears in the main window. 
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3.5.3  Displaying gridlines

You can show or hide the gridlines by selecting the View / Gridlines menu options. 

1. Click View / Gridlines in the menu bar to display the check mark.

The gridlines are displayed in the main window. 

The view with activated gridlines is set by default. 

3.5.4  Deactivating the gridline display

2. Click View / Gridlines in the menu bar to hide the check mark.

The gridlines are not displayed in the main window.
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3.5.5  Displaying names

You can use the View / Names menu option to toggle the display of station numbers and 
names.

1. Click View / Names in the menu bar to display the check mark. 

The names are displayed in the main window.

3.5.6  Deactivating the name display

1. Click View / Names in the menu bar to hide the check mark. 

The station numbers are displayed in the main window instead of the names. 

The station number is always displayed if a name is not assigned to a station number.
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3.5.7  Displaying the legend

The legend indicates the colors that are assigned to the ringing states.

You can show or hide the legend using the View / Legend options.

1. Click the Legend option to display the check mark.

The legend is displayed in the main window.

3.5.8  Deactivating the legend display

1. Click the Legend option to hide the check mark.

The legend is not displayed in the main window.
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3.5.9  Activating/Deactivating „Always on top“

1. Click the Always on top option to display the check mark.

BLF-Win is then always on the uppermost position of the desktop even if BLF-Win is 
not the active program.

2. To deactivate the function click on Always on top again to hide the check mark.

BLF-Win will then go automatically in the background when another program is 
activated.

3.5.10  Displaying canonical numbers

You can show or hide the canonical numbers by selecting the View / Canonical number 
menu options.

1. Click View / Canonical number in the menu bar to display the check mark.

The subscribers are displayed as canonical number in the main window.
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3.5.11  Hiding canonical numbers

1. Click View / Canonical number in the menu bar to hide the check mark.

The short number are displayed in the main window.

The view with short numbers is set by default.

3.5.12  Defining a prefix

You can define a prefix that is used to indicate the new subscribers and subscriber ranges 
states in the display panel by selecting the Tools menu option.

1. Click Tools / Options / Prefix... in the menu bar.

2. Enter the Prefix number e.g. +49(1)200-

3. Click OK.

The prefix is stored now.
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3.5.13  Defining colors

You can customize the colors that are used to indicate the various ringing states in the 
display panel by selecting the Tools menu option.

1. Click Tools / Options / Colors... in the menu bar.
A dialog box for editing the status colors opens.

2. Click one of the status options, for example, Idle.
A dialog box containing the color palette appears.

3. Select a color by clicking it with the mouse.

4. Click OK. 

The selected status is displayed in the selected color. 
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3.5.14  Cell size

You can use this menu option to change the cell size and width in the display panel. 

1. Click Tools / Options / Cellsize... in the menu bar.

2. Enter a value for the horizontal size of the cell (the cell size is specified in dots).

3. Enter a value for the vertical cell size.

4. Confirm your entries by clicking OK.

The settings will take effect. 

3.5.15  Font

You can set the font for all cells using this menu option. 

1. Click Tools / Options / Font... in the menu bar.

2. Select a font, for example, Arial.

3. Click OK. 

The settings will take effect.
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3.6  User administration

Permission to save files and to change the password is granted using the Tools / User 
menu option. 

3.6.1  Administrator mode

1. Click the Tools / User / Administrator mode option.

2. Enter the password.

The default password is: HIPATH (uppercase letters)

3. Click OK. 

The Save and Save as... menu options are activated in the menu bar under File if the 
password is correct. 

Administrator mode is activated and a check mark   is displayed. 

You can now save current configurations (<configuration name>.blf). All settings 
(colors, index cards, subscribers and subscriber groups) are saved.
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3.6.2  Changing the password 

1. Click the Tools / User / Change password menu options.

2. Enter the old password in the first box. 

3. Enter the new password once in the two other boxes. 

4. Click OK.

The new password is now valid.
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3.7  Using the Help

You can obtain information about the version and copyright details of BLF-Win-Client by 
selecting About.... 

Selecting Contents... F1 provides you with information about the operation and setting 
options of BLF-Win.

F1 is the hot key for the Help function. Pressing this key provides you with information about 
the operation and setting options of BLF-Win.
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4  Managing BLF-Win

This chapter describes how to create new index cards, subscribers and subscriber ranges 
and how to edit existing ones.

4.1  Managing index cards

You can create a new index card or edit, delete or copy an existing one by right-clicking the 
mouse. 

1. Position the mouse pointer in the index card row beside the existing index cards. 

2. Right-click the mouse.

A menu opens. This menu allows you to create a new index card or edit the active one. 

or

1. Position the mouse pointer on the active index card.

2. Right-click the mouse.

A menu opens. This menu allows you to change or delete the selected index card.

or

1. Position the mouse pointer on the inactive index card.

2. Right-click the mouse.

A menu option that allows you to rename the active index card appears.

You can find out how to create a new index card and delete or rename an active index card 
in the section entitled regarding the management of index cards: Chapter 3.3, “Editing index 
cards”.
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4.2  Managing subscribers

This section describes how to create new subscribers in BLF-Win and how to edit, copy or 
delete existing ones.

NOTE:  Hunt groups and chief/secretary configurations are not supported in versions 1.0, 
2.0  and 3.0 of BLF-Win.

4.2.1  Creating new subscribers

1. Position the mouse pointer over a blank cell.

2. Right-click the mouse.

3. Select New subscriber.

A dialog box containing three input boxes appears:

4. Enter the station number in the Subscriber’s number box.

The name is displayed in the Name box if a name is assigned to the station number. 
Otherwise this box remains blank.
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5. Select a font, if required, by selecting the Font menu option (Chapter 3.5.15, “Font”). 
The font is only changed for this one cell and not for all cells in the display panel. 

6. Enter a note, if required, in the note box.

7. Click OK.

The station number of the new subscriber is displayed in the cell. 

4.2.2  Editing subscribers

1. Position the mouse pointer over a subscriber.

2. Right-click the mouse.

3. Select Edit subscriber.... 

A dialog box opens. The name appears in the Name box if a name is assigned to the 
Subscriber’s number. Otherwise this box remains blank.

4. Edit the station number in the Subscriber’s number box.

5. Select a font if required.
The font is only changed for this one cell and not for all cells in the display panel.

6. Click OK.

The modifications will take effect.
A31003-H3200-B555-6-7619, 01/2020
BLF-Win 3.0, User manual 35



Managing subscribers
4.2.3  Deleting subscribers

1. Position the mouse pointer over a subscriber.

2. Right-click the mouse.

3. Select Delete subscriber. 

The subscriber is deleted from the display panel. 
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4.3  Managing the subscriber range

This section describes how to create new subscriber ranges in BLF-Win and how to edit, 
copy or delete existing ones.

4.3.1  Creating a new subscriber range

1. Position the mouse pointer over a blank cell.

2. Right-click the mouse.

3. Select New subscriber range.

A dialog box containing one input box appears:

4. Enter the number of the subscriber range in the Subscriber number box.

5. Select a font, if required, by selecting the Font menu option (Chapter 3.5.15, “Font”). 
The font is only changed for this one cell and not for all cells in the display panel.

6. Confirm your entries by clicking OK.

The new subscriber range appears in the selected cell.

NOTE:  A subscriber range cannot be created at the right end of the box.
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4.3.2  Editing the subscriber range

1. Position the mouse pointer over a subscriber range.

2. Right-click the mouse.

3. Select Edit subscriber range.... 

4. Enter the new number of the subscriber range in the Subscriber number box.

5. Select a font, if required, by selecting the Font menu option (Chapter 3.5.15, “Font”). 
The font is only changed for this one cell and not for all cells in the display panel.

6. Click OK. The modifications will take effect now.

4.3.3  Deleting a subscriber range

1. Position the mouse pointer over a subscriber.

2. Right-click the mouse.

3. Select Delete subscriber range. 

The subscriber range is deleted from the display panel.
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4.4  Arranging the objects in the display panel

You can reposition the subscribers and the subscriber ranges in the display panel by using 
a drag-and-drop operation. 

1. Click the object to be moved with the left mouse key.

2. Drag the object to the required position with the mouse key held down.

3. Release the mouse button.

The object has now been shifted to the required position. 

NOTE:  An object cannot be moved outside of the display panel.
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4.5  Interfaces from BLF-Win to DS-Win and AC-Win

If BLF-Win is running parallel to DS-Win, the status of a selected subscriber in DS-Win is 
displayed in the task bar on the desktop. The station number of the subscriber is displayed 
with a background color that corresponds to the subscriber’s connection status, i.e. green 
for idle, yellow for ringing, etc. (see the assignment of colors in the "Colors" section: 
Defining colors).

The figure below displays all three program running simultaneously: DS-Win, AC-Win and 
BLF-Win. 

DS-Win and AC-Win are initiated from BLF-Win using the Connectivity Adapter interface. 
The current status of the subscriber can be viewed at all times in AC-Win.
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Example:

An external call is initiated. The external caller would like to speak to subscriber 5004.

BLF-Win indicates that subscriber 5004 is idle.

1.  Select subscriber 5004.

Subscriber 5004 and subscriber 5004’s connection status can be viewed in AC-Win. 

2. Double-click subscriber 5004 in BLF-Win. 

or

3. Enter the station number 5004 in the keypad field.

The station number of subscriber 5004 appears in the First subscriber box in AC-Win 
(5004) and the subscriber’s connection status appears in the Status box (yellow for 
Ringing).

The extension of subscriber 5004 rings.

The Busy connection status with a red background is displayed in the Status box in 
AC-Win as soon as subscriber 5004 answers the call. 
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You will find more detailed information about AC-Win and switching operations in the 
AC-Win manual!

AC-Win and DS-Win are automatically shut down if BLF-Win is closed. 

4.6  Using BLF-Win in conjunction with Optiset/OptiPoint

BLF-Win can also be used in conjunction with Optiset/OptiPoint.

AC-Win and Optiset/OptiPoint have the same functionality in terms of BLF-Win. Both can 
forward an incoming call to the required extension. 

NOTE:  Optiset/OptiPoint and AC-Win cannot be operated simultaneously with BLF-Win.

Example:

An external call is received. The external caller would like to speak to subscriber 5004. 

BLF-Win indicates that subscriber 5004 is idle.

1. Double-click the field displaying 5004.

Extension of 5004 rings. This subscriber’s connection status changes to Ringing 
(yellow) in BLF.

The connection status changes to Busy (red) as soon as subscriber 5004 answers the 
call. 

The call is forwarded to subscriber 5004 and your telephone is idle again. 

The use of Optiset/OptiPoint or AC-Win allows an incoming call to be forwarded directly 
to the relevant extension. Intermediate steps such as informing the subscriber that he/
she has received a call or informing the caller that the call is being forwarded are 
superfluous.
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